
IPEVO Presenter for Mac and Windows
Quick Start Guide

Introduction
IPEVO Presenter for Mac and Windows is designed for use with the IPEVO 
line of document cameras, including Point 2 View, Ziggi-HD, iZiggi-HD,  
VZ-1 HD and Ziggi-HD Plus. Presenter displays the live video feed from your 
camera. It's an ideal solution to send live video from your computer to your 
projector for lessons and presentations. Presenter also contains numerous 
handy tools and customizations to help you get the most from your camera. 

This guide will help familiarize you with Presenter's functions and settings.

Downloading IPEVO Presenter 
 Visit support.ipevo.com for the latest version of Presenter. Click the download 
link for the Mac or Windows version, then follow the prompts to complete 
installation. Presenter is free to use and may be installed on multiple computers.

Questions? Comments?
 If you've read this guide and still have questions, we're ready to help. Email 
cs@ipevo.com and a member of our Customer Support team will be happy to 
assist you.

support.ipevo.com
mailto:cs%40ipevo.com?subject=


Status Bar Functions (Mac) / Window Functions (Windows)

Once IPEVO Presenter is installed and opened, you will see the following functions 
in the status bar (for Mac) or at the top right-hand side of the Presenter’s window 
(for Windows).

File -> New Presenter Window
Generates a new Presenter window for multiple doc cams support. Use the 
"Select Video Device" function in Camera Mode to select the appropriate doc 
cam for each window. 
 File -> Import Images
Import jpeg or png images into Presenter for viewing or for OCR and Text-To-
Speech (see section on “Text-To-Speech (TTS)” for details). 
 Window -> Minimize
Minimize the Presenter window.
 Window -> Zoom
Clicking this will cause the Presenter window to fit your screen size.
 Help -> Presenter Help
Directs you to the IPEVO support page with downloads, FAQ and a  
discussion page.
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For Mac:



For Windows:

Help
Directs you to the IPEVO support page with downloads, FAQ and a discussion page. 
 Create New Presenter Window
Generates a new Presenter window for multiple doc cams support. Use the 
"Select Video Device" function in Camera Mode to select the appropriate doc 
cam for each window. 
 Minimize
Minimize the Presenter window.
 Full Screen
Clicking this will cause the Presenter window to occupy the entire screen. 
This is useful for lessons and presentations.
 Close
Exit Presenter.
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Zoom

Mirror

Rotate

Resolution

Exposure

White Balance

AF Lock / Manual Focus

Full Screen

Select Video Device

Adjust

Snapshot

Auto (Interval Shooting)

Record

Freeze

Display Mode

Focus and Focus Indicator

Camera Mode

The default mode when starting IPEVO Presenter is Camera Mode, selectable with 
the top tab on the left-hand side. This mode displays the live image coming from 
the doc cam connected to your computer. You can also customize your image in 
several ways using the pulldown menus and buttons.
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Zoom
Digitally zoom in continuously on the subject. 1x (normal) to 12x zoom is possible.
 Mirror
Flip the image along a horizontal axis, flop the image along a vertical axis, or 
select both Horizontal and Vertical for an image that is flipped and flopped. 
The default is “Off”, i.e. no mirroring.

Rotate
Rotate the image 360 degrees. Slide the green marker to your desired degree, use 
the arrow keys for incremental rotations, or use the preset buttons for instant 
90-, 180- and 270-degree rotations. Press the Reset key to return to the original 
position. Both Mirror and Rotate are useful for orienting text so that it's readable.

Resolution
Change your resolution on the fly. Higher resolutions offer a higher-quality 
image, but they consume more computing power. If your image stutters or 
suffers from a strobe-like effect, consider lowering the resolution to increase 
the frame rate for a smoother image.

Exposure
Change your image exposure from 1 (darkest) to 15 (brightest). The default 
value is 8, i.e. medium brightness. If your image is too dark, consider 
increasing the exposure. Check the AE-Lock button to lock your camera's 
exposure to the current value.

White Balance
Control the color temperature of the image. The WB slider may be dragged 
to higher (or lower) color temperatures to correct the current low (or high) 
white balance environment to produce more neutral colors. Your selection 
will automatically lock into place with WB-Lock.
Note - White balance adjustment is only available when IPEVO Presenter is used with Ziggi-HD Plus.

 
AF Lock / Manual Focus
When the Autofocus (AF) Lock is unchecked, your camera will try to find the 
best focus for a sharp image. If you prefer manual focus instead, check the 
"AF-Lock" box, drag the slider to your desired focus, from very close (the flower 
icon) to very far away (the infinity icon), and the focus will then be locked to the 
current value. To return to Autofocus, uncheck the "AF-Lock" box.
Note - Manual focus is only available on selected IPEVO document cameras.

 
Full Screen
Clicking this will cause the Presenter window to occupy the entire screen.  
Click again to exit full screen.

Top Menu Functions
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Select Video Device
Select the video device Presenter should use. If properly connected, your 
device's name should appear here.

Special note for iZiggi-HD users – As a wireless document camera, iZiggi-HD connects to your 
computer via Wi-Fi. If you are connecting iZiggi-HD to your computer for the first time, it can take a 
minute or two for it to show up in the "Select Video Device" menu. Please allow iZiggi-HD to show up 

completely before selecting it as your video device.

Adjust
Pressing Adjust will take you to a Video Control menu with several camera 
settings you can adjust by dragging the corresponding sliders.
 
Snapshot
Take a snapshot of the current image. The snapshot will be saved on your 
hard drive as a JPG file and can be managed in Review Mode.

Bottom Menu Functions

Project Name
Name your automated snapshot series. It can be accessed in Review Mode.
Interval
Type in numbers or tap the arrow keys to set your desired interval between
snapshots in hours (HH), minutes (MM) and seconds (SS).
Total Images
Type in numbers or tap the arrow keys to set the total number of images 
(snapshots) you'd like to take in your automated snapshot series.
Time Remaining
Indicates the total time left for the current automated snapshot series  
to complete.
Start
Press Start to begin the automated snapshot series according to the 
parameters you've set.

Auto (Interval Shooting)
Clicking this will bring up a window allowing
you to set up an automated shooting 
schedule. Once set, Presenter will take 
snapshots automatically at intervals of your 
choosing. This tool is ideal for archiving 
different materials quickly, for time-lapse 
photography, and for stop-motion videos.
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Record
Record a video of the current video feed. Once you press Record, it will turn 
into the Stop button, which you can press to stop the video recording. The 
video file will be saved to your hard drive and can be managed in Review Mode.

Freeze
Pause the live image. Press again to unpause and return to live action.

Display Mode
Press to make visual overlays disappear so you have an uncluttered image 
suitable for presentation. In its default setting, the top menu elements and 
Focus and Focus Indicator are displayed. By pressing once on the “Display 
Mode” button, gridlines will appear. Press again to display only the gridlines, 
and not the menu elements and Focus Indicator. Press a third time to make 
the gridlines, menu elements and Focus Indicator disappear. The cycle will 
then start over again with a fourth press.

Focus and Focus Indicator
Indicates whether your doc cam is in Single focus mode (AF-S) or Continuous 
focus mode (AF-C). Pressing the crosshairs will cause your doc cam to find a 
new focus.
When focusing, four corners of a red box will appear in the center of the 
screen, followed by a beep sound. That means the camera is attempting 
to focus. The live image may zoom in and out slightly during the focusing 
process. When the doc cam is done focusing, the red corners will turn green, 
and you will hear a brief sound effect.
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Review Mode

Select the second tab on the left-hand side to enter Review Mode. In this mode, 
you can view and manage the snapshots (photos) and videos you've taken with 
your doc cam.

All

Photo

Video

AutoShoot

Album

Main Window Functions

Thumbnail Size (or Zoom)

Rotate

Delete

Action
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ALL
Both photos and videos will be displayed.

Photo
Display only photos.

Video
Display only videos.

AutoShoot
Display only the automated snapshot series you've taken.

Album
Display only the photo albums you've created.
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Main Window Functions
 Click on an image to select that photo or video, which will become highlighted 
in a bright yellow. Use Shift+Click and Command+Click to select multiple files. 
 
Double-click on the selected photo or video to make it larger and to enter a 
slideshow mode. Click the left or right arrows in the slideshow to view other 
photos or videos in the library. Click the Back arrow key (in green) to exit the 
slideshow. 
 
You can right-click on an image to bring up Rotate, Delete, Rename, Add to 
Album, Export to and Text-To-Speech functions.
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Thumbnail Size (or Zoom)
Adjust the slider to alter the size of the thumbnails being displayed.

Rotate
Rotate the selected photo(s) in 90-degree increments counter-clockwise. This 
rotation will permanently alter the image.

Delete
Permanently delete the selected files from your hard drive. A pop-up window will 
confirm your decision.
 
Action
Export the selected photo(s) or video(s) to a desired location on your hard drive. 
You can also export images as a PDF file to your desired location. Or you can add 
the selected photo(s) or video(s) to a new album or an existing album.

Bottom Menu Functions



Album
 
Press Album on the top menu bar to access your photo albums. Albums are 
arranged according to the date they are created. To rename an album, click twice 
on the current name to bring up an editable text field. Or, right-click on the album 
and select Rename. 
 Albums can be exported as PDF files using the Action function in the bottom-right 
corner. 

To add photos to an album, select your photo(s) and then right-click. Choose "Add 
to Album." You may either add your selected photos to an existing album, or add 
them to a new album. The default name for a new album is "unnamed." Change 
the album's name as described earlier in this section.



Multiple Doc Cams Support
 
Presenter now supports multiple document cameras. You can generate a separate 
Presenter window for each of the document camera connected to your computer. 
To do so, press Command+N (Mac) or Ctrl+N (Windows). A new Presenter window 
will be created. Use the "Select Video Device" function in Camera Mode to select 
the appropriate document camera for each of your Presenter window. 
 You can also assign the same document camera to two separate Presenter 
windows. Simply assign the same document camera for each window's "Select 
Video Device" function. For one example of how to use this function, you can have 
one window zoomed in to show details, and the other unzoomed to show the 
entire object.
 
Note - High computer performance is required when two document cameras are connected at high 
resolutions. If the image freezes or lags in this setup, consider lowering the resolution.



Select Camera 1 

Select Camera 2

Image Adjustments/
Adjust Camera

Horizontal/Vertical

Split Screen Mode 
 
Presenter also supports Split Screen Mode. Two document cameras can be 
connected and presented in splitscreen, or a single document camera's video feed 
can be presented in splitscreen. Functions like zoom, resolution change, rotate 
and more can be changed independently in each splitscreen pane.
 Note - Do not use a USB hub for this purpose. You’ll need to plug the two document cameras into the USB 

ports on your computer. If the second screen shows no live image, try a different USB port.

 
To enter Splitscreen Mode, click on the "Split Screen" tab on the left.
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Select Camera 1
Select the camera for the first splitscreen pane.

Select Camera 2
Select the camera for the second splitscreen pane. It can be the same or 
different from Camera 1.

Image Adjustments/Adjust Camera 
Within the Select Camera pop-up, hit Image Adjustments/Adjust Camera to 
tweak the image coming from the selected camera.

Horizontal/Vertical
Splitscreen can be presented either horizontally or vertically depending on 
your selection.

Each splitscreen pane can be further adjusted by hitting the ">" icon in the upper 
right to bring up more options. Hit "<" again to collapse the options. 

Note - High computer performance is required when two document cameras are connected at high 
resolutions. If the image freezes or lags in this setup, consider lowering the resolution.
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Zoom
Digitally zoom the image.
Rotate
Rotate the image.
Resolution
Change the resolution of the image.
Exposure
Brighten or darken the image.
Focus Adjustment
Drag the Focus slider to the desired focus, which will lock into place. To 
return to Autofocus, uncheck the "AF-Lock" box.
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Settings (Mac)

Click on the gear icon on the left-hand side (below the mode tabs) to enter Settings.

General          Snapshot          Recording          AdvancedA
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General

Camera Sounds On
By default, there are brief sound effects when focusing and when taking a 
snapshot. Uncheck these options to silence these effects.
Refresh Rate
Choose between 60Hz and 50Hz depending on your computer monitor's 
refresh rate.
Keep Camera Mode Settings
By default, settings you change will stay that way when you launch 
Presenter in the future. Select “No” to return to original settings each time 
you launches Presenter.
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Create new album by date automatically
When checked, any snapshots you take will automatically be placed within 
an album according to the date when the snapshot was taken. Uncheck to 
prevent the automatic creation of albums.

Show high resolution live viewing tip
When checked, Presenter will pop up a window when you choose a higher 
resolution with the following text: "A higher resolution will increase 
demands on your CPU. If you are experiencing laggy or frozen video 
streaming, please reduce the resolution." 

Show high resolution recording tip before recording
When checked, Presenter will pop up a window when you start recording 
with the following text: "Using a higher resolution to record videos will 
increase demands on your CPU. If you are experiencing laggy or frozen 
video streaming, or the audio and video are out of sync, please reduce the 
resolution."



Custom File Saving Settings
When checked, you will be able to save a copy of your photo/video files to 
a designated folder, and to customize file names. For more information 
on this option, click on Help (question mark icon) beside the option.



Snapshot

Instant Preview
Preview the snapshot you've just taken before returning to the live view. 
Default is “Off” (no preview). Choose between a two-second preview and 
four-second preview.
Snapshot Timer
Once you press the snapshot button, tell the camera to wait either 3 
seconds or 10 seconds before taking the snapshot. Default is “Off” (no 
delay between button press and captured snapshot).
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Recording

Resolution
Choose Auto Detect to have Presenter determine the best resolution 
to record your video. Or, you may choose your own custom resolution.
Audio Device
Select your preferred audio device from the pulldown menu for use in 
conjunction with your doc cam.
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Advanced

Display TTS (Text-To-Speech) button in Camera Mode
When checked, a TTS button will be displayed in Camera Mode. You can 
click on the button to take a snapshot of a text and send it for OCR and 
Text-To-Speech. For more information on this option, see section on “Text-
To-Speech (TTS)”.
Press Close to apply any changes to Settings you have made.
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Settings (Windows)

Click on the gear icon on the lower left-hand corner to enter Settings. 

About                Advanced            License        

General             Snapshot             Recording
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A General

Camera Sounds On
By default, there are brief sound effects when focusing and when taking a 
snapshot. Uncheck these options to silence these effects.
Keep Camera Mode Settings
By default, settings you change will stay that way when you launch 
Presenter in the future. Select “No” to return to original settings each time 
you launches Presenter.
Refresh Rate
Choose between 60Hz and 50Hz depending on your computer monitor's 
refresh rate.
Library Location
Change the location on your hard drive where snapshots and videos taken 
in Presenter are stored.
Language
Choose your desired language for menu text from the pulldown menu.
Create new album by date automatically 
When checked, any snapshots you take will automatically be placed within 
an album according to the date when the snapshot was taken. Uncheck to 
prevent the automatic creation of albums.
Show video recording restrictions before starting 
When checked, Presenter will pop up a window when you start recording 
with the following text: "Please note that the highest resolution available 
in recording mode is 1280 x 720. The Zoom, Mirror, and Rotate functions 
are not supported in recording mode."
Custom File Saving Settings 
When checked, you will be able to save a copy of your photo/video files to 
a designated folder, and to customize file names. For more information 
on this option, click on Help (question mark icon) beside the option.







B Snapshot

Instant Preview
Preview the snapshot you've just taken before returning to the live view. 
Default is “Off”  (no preview). Choose between a two-second preview and 
four-second preview.  
Snapshot Timer 
Once you press the snapshot button, tell the camera to wait either 3 
seconds or 10 seconds before taking the snapshot. Default is “Off”  (no 
delay between button press and captured snapshot).



C Recording 

Select Audio Device
Select your preferred audio device from the pulldown menu for use in 
conjunction with your doc cam. 



D About 

This tab lists the version of Presenter you are using, its End User License 
Agreement (EULA) and Privacy Policy. Check support.ipevo.com frequently 
to ensure you have the latest version of Presenter. 



E Advanced 

Enable TWAIN support – When checked, TWAIN support will be enabled, 
turning the IPEVO doc cam you’re using into a TWAIN-compatible scanner. 
A Green TWAIN icon will appear at the bottom right hand corner of 
Presenter’s Camera Mode. You’ll be able to use any IPEVO doc cams 
together with the Presenter as a virtual scanner for most 3rd party TWAIN-
based scanning software.



Display TTS (Text-To-Speech) button in Camera Mode
When checked, a TTS button will be displayed in Camera Mode. You can 
click on the button to take a snapshot of a text and send it for OCR and 
Text-To-Speech. For more information on this option, see section on “Text-
To-Speech (TTS)”.
Press Close to apply any changes to Settings you have made.



Text-To-Speech (TTS) 
 Presenter now includes a Text-To-Speech function (for English language only) that 
allows users to take a snapshot of a text document and immediately OCR it into an 
editable text for reading aloud by the computer.

By default, the Text-To-Speech (TTS) function is disabled. You’ll need to enable it by 
going to the “Advanced” tab under “Settings” icon and click on the option “Display 
TTS (Text-To-Speech) button in Camera Mode”. A TTS button will then appear 
beside the “Record” button in Presenter’s Camera Mode. You can now place any 
English text under your doc cam, focus it, press the TTS button and let Presenter 
take a snapshot of the text for OCR in a pop-up window. All snapshots taken will 
be saved to a “Text-to-Speech” album.

After the OCR has completed, press “Start” to start listening to the text. Press “Next” 
to skip to the next sentence or “Previous” to jump back to the previous sentence. If 
your computer has both male and female voices installed, you have the option of 
choosing either one using the “Male” or “Female” voice button. Otherwise, the text 
will be read aloud using the default voice available on your computer.

Besides pressing the TTS button, there’s another way to access Text-To-Speech: 
Right click on any existing text images in Review Mode and choose “Text-To-Speech”. 
And if you are using a Mac computer, you can drag and drop any text images into 
Presenter’s Review Mode or import them into Presenter (see section on “Status 
Bar Functions (Mac)”) for Text-To-Speech purpose.



Hotkeys

Please familiarize yourself with common Presenter functions accessible 
via hotkeys.

Zoom in and Zoom out

Zoom reset

Mirror (Horizontal) and Mirror (Vertical)

Rotate

Rotation reset

Exposure change

Exposure reset

Exposure lock

Manual focus

Autofocus lock

Focus

Freeze/Resume

Toggle display mode

Take a snapshot

Full Screen/Windowed

Exit Full Screen

Function Windows & Mac

-, =

0

h, v

left, right

r

up, down

e

a

alt+up, alt+down (Windows)/ 
option+up, option+down (Mac)

m

f

p

d

space

alt+enter(Windows)/ 
option+enter (Mac)

esc


